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Copyright  Ó 1995 by this company.  All rights reserved.  No part of

this publication may be reproduced, transmitted, transcribed, stored in

a  retrieval  system,  or  translated  into  any  language  or  computer

language,  in  any  form  or  by  any  means,  electronic,  mechanical,

magnetic,  optical,  manual  or  otherwise,  without  the  prior  written

permission of this company.
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Disclaimer

This  company  makes  no  representations  or  warranties,  either

expressed  or  implied,  with  respect  to  the  contents  hereof  and

specifically disclaims any warranties, merchantability or fitness for any

particular purpose.  Any software described in this manual is sold or

licensed "as is".  Should the programs prove defective following their

purchase,  the  buyer  (and  not  this  company,  its  distributor,  or  its

dealer) assumes the entire cost of all necessary servicing, repair, and

any incidental or consequential damages resulting from any defect in

the software.  Further, this company reserves the right to revise this

publication and to make changes from time to time in the contents

hereof  without  obligation  to  notify  any  person  of  such  revision  or

changes.

AMI is a registered trademark of American Megatrends Inc.
Pentium is a registered trademark of Intel Corporation.
PC XT/AT is a registered trademark of International Business Machines Corporation.
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FCC Statement

FCC Class B Radio Frequency
Interference Statement

Note:

This equipment has been tested and found to comply with the limits
for a Class B digital device, pursuant to Part 15 of FCC Rules.  These
limits are designed to provide reasonable protection against harmful
interference in a residential installation.  This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and
used  in  accordance  with  the  instructions,  may  cause  harmful
interference  to  radio  communications.   However,  there  is  no
guarantee that interference will not occur in a particular installation.  If
this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or
more of the following measures:

1. Reorient or relocate the receiving antenna.

2. Increase the separation between the equipment and receiver.

3. Connect the equipment into an outlet on a circuit different from that
to which the receiver is connected.

4. Consult the dealer or an experienced radio/television technician for
help.

Notice 1:

The changes or modifications not expressly approved by the party
responsible for compliance could void the user's authority to operate
the equipment.

Notice 2:

Shielded interface cables, if any, must be used in order to comply with

emission limits.
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About this Manual

Purpose and Scope

This manual tells how to install and configure the system board.

Organization

This manual consists of five chapters and one appendix.

Chapter 1,  Features, covers the specifications,  layout and components of

the system board.

Chapter 2, Hardware Setup, tells how to set the jumpers, upgrade the CPU

and the system memory, install the system board and add expansion cards.

Chapter 3, AMI BIOS, explains the system BIOS and tells how to configure

the system by setting the BIOS parameters.

Chapter 4, VGA, describes the video graphics accelerator on board, and lists

the supported applications and display modes.

Chapter 5, Audio Chip, discusses the onboard 16-bit sound processor and

tells how to install the audio drivers and utilities. 

Appendix A, Jumper Summary, gives you a tabular summary of the jumper

settings  discussed  in  Chapter  2.   It  also  gives  a  list  of  the  onboard

connectors.
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About this Manual

Conventions

The following conventions are used in this manual:

Text entered by user, 
default settings

Represent  text  input  by  the  user,
default  settings  and  recommended
selections

message displayed Denotes actual  messages that  appear
on screen

a, e, s, etc Represent  the  actual  keys  that  you
have to press on the keyboard.

NOTE
Gives bits and pieces of additional 
information related to the current topic.

WARNING
Alerts you to any damage that might 
result from doing or not doing specific 
actions.

CAUTION
Suggests precautionary measures to 
avoid potential hardware or software 
problems.

IMPORTANT
Reminds you to take specific action 
relevant to the accomplishment of the 
procedure at hand.

TIP
Tells how to accomplish a procedure 
with minimum steps through little 
shortcuts.
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Chapter

Features 1

The LP5 is an all-in-one PentiumÔ -based motherboard that features

an  onboard  video  graphics  accelerator  (VGA)  and  a  16-bit  sound

processor.   It  integrates  the  Intel  Triton  82437FX,  82438FX  and

82371FB application-specific  integrated circuit  (ASIC)  chipsets  that

enable the System Management Mode (SMM) function of the Pentium

chip.  The board also features the Dark Green power management

that extends energy conservation from system components to display

monitors.

The  system  board  utilizes  the  PCI/ISA  architecture.   The  system

memory is expandable to 128 MB by adding single in-line memory

modules (SIMMs) that support either the Extended Data Out (EDO) or

the  Fast-page  Mode  DRAMs.   The  board  may  come  with  a

256-KB/512-KB  asynchronous  second-level  cache  or  a  256-KB

pipeline-burst memory.

A super I/O controller and a PCI mode 4 enhanced-IDE controller with

bus master support are incorporated in the design to further enhance

system  performance.   An  optional  fax/modem  module  is  also

available.  The board measures 220 mm x 330 mm (LPX size).  

Since  the  board  does  not  have  a  conventional  arrangement  of

connectors, the board package includes a sticker that serves as port

indicator.  
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Features

Specifications

Microprocessor Pentium™ (3.3V) Processor 
75/90/100/120/133/150/166 MHz

Max. Memory 128 MB

SIMM Sockets Four 72-pin, 32-bit 
Supports EDO or Fast Page Mode DRAMs

ASICs Intel Triton 82437FX
Intel Triton 82438FX
Intel Triton 82371FB

I/O Chip SMC FDC37C665GT

VGA S3 Trio64

Audio Chip Creative CT2504

Bus
Architecture

PCI, ISA

Expansion Slot One riser card slot

Riser Card Single-sided riser card:    Two PCI slots 
            Two ISA slots
            One PCI-/ISA-shared slot

Double-sided riser card:   Two PCI slots 
            Two ISA slots

Ports One parallel port (SPP/ECP/EPP)
Two serial ports (UART 16C550)
Two-channel PCI mode 4 enhanced IDE
One floppy disk port 
(1.2/1.44/2.88 MB, 3-mode floppy support)

Secondary
Cache

256-KB/512-KB asynchronous or
256-KB pipeline-burst cache

BIOS AMI Plug-and-Play Flash EPROM BIOS

RTC and Battery Dallas DS12887A

Board Size 220 mm x 330 mm (LPX)
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Features

Board Layout

1. VGA connector 20. IDE1 connector
2. Game/MIDI port 21. Parallel port connector
3. Speaker out 22. Voltage regulator with heatsink
4. Line in 23. Pipeline-burst cache
5. Volume control 24. Asynchronous cache
6. Mic in 25. CPU socket
7. COM1 port 26. CPU fan connector
8. PS/2 mouse connector 27. Intel 82438FX ASIC (TDP)
9. PS/2 keyboard connector 28. SIMM sockets
10. Fax/modem module (optional) 29. Intel 82437FX ASIC (TSC)
11. Riser card slot 30. Clock generator
12. Creative CT2504 audio chip 31. Intel 82371FB ASIC (PIIX)
13. Fax/modem connector 32. BIOS
14. Super I/O chip 33. VGA feature connector
15. COM2 port connector 34. S3 Trio64 audio chip
16. FDC connector 35. First 1-MB video DRAM
17. Power connector 36. Second 1-MB video DRAM sockets
18. RTC and battery 37. Keyboard controller
19. IDE2 connector
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Features

The  heatsink  becomes  very  hot  when  the
system is  on.   NEVER touch  the  heatsink
with any metal or with your hands.

System Board Parts

Microprocessor

The  LP5  system  board  uses  an  Intel  Pentium  (3.3V)  processor

running at speeds of 75, 90, 100, 120, 133, 150 or 166 MHz.  Chapter

2 tells details on how to upgrade the Pentium processor.
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Features

ASICs

The ASICs onboard are the 82437FX, 82438FX and 82371FB.  The

82437 serves as the system memory controller and PCI bus interface.

The two 82438FX ASICs function as PCI local-bus data paths that

offer 64-bit DRAM and 32-bit PCI bus interfaces to support the 64-bit

Pentium processor data bus.  

The 82371FB acts as the PCI-/ISA-bus bridge that translates the PCI

bus cycles into ISA bus cycles or vice-versa.  It also functions as the

PCI fast-IDE interface and the SMM controller.

AMI BIOS

The AMI BIOS (basic input-output system) resides in the flash ROM

chip.  This contains the program that performs the power-on self-tests

(POST)  upon  booting.   During  POST,  this  program  activates  the

peripheral devices, tests onboard memory, and prepares the system

for operation.  Chapter 3 gives more information on the AMI BIOS.

Local-bus VGA Accelerator

The system board has an onboard S3 Trio64 graphics accelerator

and a 1-MB video memory expandable to 2 MB.  These enable the

LP5 to support VESA Display Power Management Signalling (DPMS)

monitors.  For more details on the onboard VGA, see Chapter 4.

                                                                                                                                             
User’s Guide 1-5



Features

16-bit Sound Chip

The onboard sound chip is a 16-bit Creative CT2504.  It offers true

16-bit  audio and is  compatible  with  Sound Blaster  Pro and AdLib,

enabling the LP5 to serve multimedia purposes.  Chapter 5 discusses

the features of this audio chip in detail.  

Two-channel PCI Mode 4 Enhanced IDE

The board integrates two-channel PCI mode 4 enhanced-integrated

drive  electronic  (E-IDE)  interfaces  with  bus  master  support.   This

improves  the  data  transfer  rate.   The  E-IDE  interfaces  allow  the

system to support four E-IDE devices, including hard disks with more

than  528-MB  capacity.   This  feature  offers  users  increased  data

storage capacity.

Fax/Modem (Optional)

The LP5 may come with an optional fax/modem module.  The module

uses the Cirrus Logic chipset and has a fax/data rate of 14.4 kbit/sec.

It conforms to the CCITT V.32bis protocol.  

For more details on the fax/modem function, refer to the manuals that

come with the module.
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Features

Super I/O Controller

The onboard super I/O controller chip SMC 37C665GT supports two

UART 16450/16550-compatible serial ports and a parallel port (SPP,

EPP, ECP)1.   It  also accommodates 1.2-/1.44-/2.88-MB disk drives

allowing full-range access to 5.25-inch drives with 360-KB or 1.2-MB

format and 3.5-inch drives with 720-KB, 1.44-MB or 2.88-MB format.  

The I/O chip also supports the three-mode Japanese floppy drives.

Expansion Slot

The  system  board  has  one  riser  card  slot  for  add-on  card

connections.  Chapter 2 tells how to install a riser card.

DRAM Sockets

The system board has four 72-pin DRAM sockets that expand system

memory to a maximum of 128 MB.  These sockets accept single- and

double-density SIMMs with the EDO or the Fast-page Mode feature.

Chapter 2 tells how to install memory modules and lists the possible

memory configurations.

Keyboard and Mouse Connectors

The system board accepts PS/2 keyboard and mouse connectors.

See Chapter 2 for information on how to install  a keyboard and a

mouse. 

1  SPP:  Standard Parallel Port
EPP:  Enhanced Parallel Port (IEEE 1284 compliant)
ECP:  Extended Capabilities Port (IEEE 1284 compliant)
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Features

SRAM

The  system board  may  come  with  either  a  256-KB  pipeline-burst

cache or a 256-KB/512-KB asynchronous cache.

Power Management

The LP5 features a system power-management mode (Dark Green)

that  conforms  to  the  power-saving  standards  of  the  U.S.

Environmental Protection Agency (EPA) Energy Star program.  See

Chapter 3 for more information on the power-management mode.
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Chapter

Hardware Setup 2

This chapter tells how to set jumpers, upgrade system memory, add

expansion boards, and install the system board.

Install the CPU, memory, and set the jumpers before you install the

board inside a housing.  You may add the other components after

installing the board.  Read this chapter to learn about the components

before you install them.

ESD Precautions

Electrostatic  discharge  (ESD)  can  damage your  CPU,  disk  drives,

expansion  boards,  and  other  components.   Always  observe  the

following precautions before you install a system component.

1. Do not remove a component from its protective packaging until

you are ready to install it.

2. Wear a wrist grounding strap and attach it to a metal part of the

system unit before handling components.  If a wrist strap is not

available, maintain contact with the system unit throughout any

procedure requiring ESD protection.
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Hardware Setup

Installing a Microprocessor

The motherboard has a zero-insertion force microprocessor socket

that allows you to install a Pentium CPU without using any tools.

Follow these steps to install a Pentium CPU in a ZIF-type upgrade

socket:

Make sure that the system power is OFF
before installing a component.

1. Attach the heatsink and the fan to the CPU. 

CPU in socket

Heatsink
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Hardware Setup

CPU in socket 
(with heatsink)

Fan

2. Pull up the socket lever.

3. Insert the CPU with the attached heatsink and fan.  Make sure

that pin 1 of the CPU aligns with the hole 1 of the socket.  The

notched corner on the CPU indicates pin 1.

4. Pull down the socket lever to lock the CPU into the socket.
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Hardware Setup

5. Plug  the  fan  cable  into  the  fan  connector.   See  the  section

Connectors for details on the fan connector.

6. Set the jumpers accordingly.  See the following sections for the

correct jumper settings.
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Hardware Setup

Upgrading the Microprocessor

Follow these steps  to  upgrade the Pentium CPU from 75 MHz to

90,100, 120, 133, 150 or 166 MHz:

1. Turn off the system power.

2. Remove the housing cover and locate the CPU socket on the

system board.

3. Pull up the socket lever.

4. Remove the installed CPU.

5. Install  the  upgrade  CPU.   Refer  to  the  section  Installing  a

Microprocessor for instructions on how to install a Pentium CPU.

6. Set the jumpers accordingly.  See the following sections for the

correct jumper settings.
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Hardware Setup

Jumper Settings

You have to change the jumper settings when you reconfigure the

system.  This section tells how to set the jumpers.  The figure below

shows the jumper locations.
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Hardware Setup

Set a jumper switch as follows:

· To close a jumper, insert the plastic jumper cap over two pins of a

jumper.

· To open a jumper, remove the jumper cap.

The following conventions are used to represent the proper jumper

settings:
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Hardware Setup

Selecting the CPU Type

The jumpers JP9, JP10, JP11 and JP13 let you select the CPU type.

The available settings are as follows:
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         CPU TYPE     JP9         JP10  JP11     JP13

   P54C-75

   P54C-90

   P54C-100

   P54C/CS/CQS-120

   P54C/CS/CQS-133

   P54CS/CQS-150

   P54CS/CQS-166



Hardware Setup

Selecting the Memory Mode

The system board supports both the EDO and the Fast-page Mode

memory features.  If you want to install memory with EDO features,

you must set jumper JP6 to 2-3.  Otherwise, set the jumper to 1-2 for

the Fast-page Mode feature.
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Hardware Setup

Setting the Cache Size

The motherboard comes either with a 256-KB pipeline-burst cache or

a  256-KB/512-KB  asynchronous  cache.   The  pipeline-burst  cache

improves system performance by reducing the standard processing

time.  

See the following figure for the location of the second-level cache.

See the table below for the various cache configurations.

Cache 
Size

Tag SRAM  (U36) 
(SOJ-type, 15 ns)

Data SRAM
(U53, U54, U55, U56, 
U58, U59, U60, U61)

256 KB 32 Kb x 8 x 1 pc. or
16 Kb x 8 x 1 pc.

32 Kb x 8 x 8 pcs (SOJ type, 15 ns)

512 KB 32 Kb x 8 x 1 pc. or
16 Kb x 8 x 1 pc.

64 Kb x 8 x 8 pcs (SOJ type, 15 ns)

256 KB (p.b.) 32 Kb x 8 x 1 pc or
16 Kb x 8 x 1 pc.

32 Kb x 32 x 2 pcs (QFP type, 8 ns)
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Hardware Setup

Also, you must reset jumper JP14 if you upgrade the cache.  See the

figure below for the correct jumper settings.  

Selecting the Flash ROM Type

Set the jumper JP7 according to the Flash ROM type.  If you use a 5V

Flash ROM, then you must close pins 2-3 of JP7.  For a 12V Flash

ROM, the required setting is 1-2.  The default setting is 2-3.
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               CACHE SIZE           JP14

256 KB

512 KB

Flash ROM Type JP7

  12 V

   5 V



Hardware Setup

Enabling the Onboard Super I/O Controller

The onboard super I/O controller is SMC37C665GT.  If you want to

enable or disable the onboard I/O controller you must reset the jumper

marked JP8 on the system board.   

Selecting the ECP DMA Channel

The jumpers  JP3 and  JP4 let you select the DMA channel for ECP

function.  The channel selections are DMA 1 and DMA 3.
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   JP8

    Enabled

    Disabled

  JP3       JP4

DMA 1

DMA 3



Hardware Setup

Enabling the VGA

The VGA chip onboard is S3 Trio64.  To enable the VGA chip, set

jumper JP5 to 1-2.  Otherwise, set it to 2-3.  

Selecting the Audio Output

You may direct your audio output to line out or speaker out.  If you

select  speaker  out,  the  audio  signal  passes  through  the  onboard

amplifier module before output.  Selecting line out lets you bypass the

amplifier module and allows you to use an external amplifier.

You must set jumpers JP1 and JP2 according to the selected audio

output.  See the figure for the proper jumper settings.
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VGA  JP5
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Disabled



Hardware Setup

Selecting the Audio I/O Address

The  jumpers  J1 and  J2 let  you  select  the  I/O  address  for  audio

function.  The available selections are 22XH, 24XH, 26XH, and 28XH.

See  the  following  figure  for  the  corresponding  settings  for  each

address.

Clearing the CMOS

The jumper JP12 clears the values in the CMOS.  You need to clear

the CMOS if you forget your system password.  To do this, shut off

the system power and short  pins  2-3 of  JP12 for  a few seconds.

Reset the jumper to the normal setting by shorting pins 1-2 with a

jumper cap.  Enter Setup to specify a new password.
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                     JP12

   Default  (Normal)

   Clearing CMOS

   Audio I/O Address   J1          J2

22XH

24XH

26XH

28XH



Hardware Setup

Memory Configuration

The system board supports a maximum memory of 128 MB.   The

four 72-pin SIMM sockets accommodate 4- and 16-MB single-density

SIMMs, and 8- and 32-MB double-density SIMMs - with or without the

Extended Data Out (EDO) function.  The EDO feature expands data

output efficiency (speed), thus improving memory performance.  All

SIMMs support a DRAM speed of 70/60 ns (or less).  Refer to the

section Board Layout and see the figure for the location of the SIMMs.

The  table  below  lists  the  SIMM  types  and  their  corresponding

capacities.

SIMM Type Capacity

1 Mb x 32/36 4 MB

2 Mb x 32/36 8 MB

4 Mb x 32/36 16 MB

8 Mb x 32/36 32 MB
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Hardware Setup

The following are the possible SIMM configurations.

Total Memory SIMM 0/1 SIMM 2/3

8 MB 4 MB x 2

16 MB 4 MB x 2 4 MB x 2

16 MB 8 MB x 2

32 MB 8 MB x 2 8 MB x 2

32 MB 16 MB x 2

40 MB 16 MB x 2 4 MB x 2

48 MB 16 MB x 2 8 MB x 2

64 MB 16 MB x 2 16 MB x 2

64 MB 32 MB x 2

72 MB 32 MB x 2 4 MB x 2

80 MB 32 MB x 2 8 MB x 2

96 MB 32 MB x 2 16 MB x 2

128 MB 32 MB x 2 32 MB x 2
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Hardware Setup

Installing a SIMM

Observe  the  ESD  precautions  when
installing components.

Follow these steps to install a SIMM:

1. Slip a SIMM at a 45o angle into a socket with the component side
facing down.  Always install SIMMs beginning with SIMM 0.

Be  careful  when  inserting  or  removing
SIMMs.   Forcing a SIMM in  or  out  of  a
socket  can  damage  the  socket  or  the
SIMM (or both).

2. Gently push the SIMM up until the pegs of the socket slip into the
holes on the SIMM and the holding clips lock the SIMM into a
vertical position.

The SIMM should be at a 90o angle when
installed.
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Removing a SIMM

1. Press the holding clips on both sides of the SIMM outward to
release it.

2. Press the SIMM downward to about a 45o angle.

3. Gently pull the SIMM out of the socket.
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Connectors

Multifunction Connector

This  20-pin  connector  is  marked  CN21 on  the  system  board.   It

supports  a number of  system functions:   green mode LED,  power

LED,  break  switch,  keylock,  and  speaker.   Attach  the  front  panel

connectors to the corresponding pins as in the illustration below.

( Turbo Switch ) ( Turbo LED )

Break Switch Green Mode LEDReset

Speaker Power LED Keylock

Some housings have a five-pin connector for the keylock and power

LED.  See the following illustration.

                                                                                                                                             
User’s Guide 2-19

      Speaker          Power LED   Keylock



Hardware Setup
Speaker Keylock & Power LED

Break Switch Green Mode LED

( Turbo Switch ) ( Turbo LED )

Reset

Other housings may have a 12-pin connector.  If your housing has

this type of connector, plug it into CN21 as shown in the following

figure.  Make sure that the red wire of the connector connects to pin

11.

( Turbo Switch )

Break Switch

Ground

VCC

Ground

Ground

KeylockReset

Res-VCC
Speaker
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Break Switch

The break switch gives the user the option to directly enter the system

suspend mode by setting the switch to the on position.  To set, simply

press the switch.  Make sure that the break switch is in the off position

before you set it to the on position.  To set it to the off position, simply

press the switch to release it from the on position.

Keyboard and Mouse Connectors

The  board  accepts  PS/2  keyboard  and  mouse  connectors.   The

following figure shows how to connect a keyboard (or mouse).
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Power Connector

A standard power supply has two cables with six wires each.  Attach

these cables to the power connector on the board in such a way that

all the black wires are in the center.  The power connector is marked

CN13 on the system board.

Fan Connector

The 2-pin fan connector is marked CN20 on the system board.  The

figure below shows the pin configuration of the connector.

2-pin fan power connector (J2)

GND
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Installation

The LP5 board conforms to the LPX standard form factor.   It  has

mounting holes that fit LPX housings.  However, before installing the

system board,  make sure  that  the  housing  accommodates  a  LPX

board with long opening in the rear panel for the onboard connectors.

Some housings may differ slightly in design, requiring additional steps

to install  the board.   Read the documentation that  comes with the

housing.

Make sure that you have already installed
the  system  board  components  like  the
CPU  and  memory,  and  have  set  the
appropriate jumpers before you proceed.

Installing the System Board

1. Open the system housing.

2. The system board comes with a bracket and hex screws.  Attach

the bracket  to the board with the hex screws.  See the figure

below.
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3. Use the screws that come with the housing to secure the board.

4. Attach the power supply cables to the power connector and the

front panel connectors to the multifunction connector.  See the

section Connectors.

5. Install any additional components that you have not yet installed.

Installing a Riser Card

Follow these steps to install a riser card:

1. Observe  the  ESD precautions  before  removing  the riser  card

from its protective packaging.

2. Locate the riser card slot on the system board.  See the section

Board Layout.

3. Gently insert the golden edge of the riser card into the slot until it

fits.
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4. Make sure that the riser card is properly seated.
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Installing Expansion Boards

Install  any  expansion  boards  after  you  have  secured  the  system

board and the riser card in the housing.

Follow these steps to install an expansion board.

1. Observe  the ESD precautions  before removing the expansion

card from its protective packaging.

2. Remove the bracket opposite the slot that you want to use.  Save

the cover for future use.  Save the screw to secure the expansion

board.

3. Remove the board from its protective packaging.

4. Gently insert the golden edge of the board into the slot on the

riser card until it fits into place.

5. Secure the board bracket with the screw.
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Applying the Port Indicator Sticker

The board comes with a silver sticker that serves as port indicator.  It

has the following indicators on it.

MODEM    K/B    MOUSE   COM1    MIC   VOL    LINE   SPK    MIDI/GAME
VGA

To apply the sticker:

1. Remove the protective paper backing from the sticker.

2. Position  the  sticker  over  the  rear  panel,  just  above  the

connectors.   Align  each  indicator  with  the  connectors  on  the

board.  Press the sticker evenly to adhere.    
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AMI BIOS 3

AMI BIOS Setup Main Menu

The AMI BIOS Setup Main Menu appears below.  Press  c during

POST to enter the BIOS Setup.

The AMI BIOS is in Windows form.  You can use either the keyboard

or a mouse to move between the items.  To select among the Setup

groups, use  v to highlight the selected group or simply click on the

icon of the selected Setup menu.  

To select among the options, you can either use the arrow keys to

move  the  highlight  bar  or  simply  click  on  the  icon  of  the  desired

option.  

After selecting, press e or double-click on the icon to open the menu.
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Standard CMOS Setup

Highlight Setup using  v or simply click on the Setup icon.  Select

Standard to input configuration values such as the date, time, and

disk  types.   The  Standard  CMOS  Setup  pop-up  window  appears

below:

Date/Time

To  set  the  date  and  time,  highlight  Date/Time and  press  e or

double-click on the Date/Time icon.  The following screen appears:
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Use the arrow keys to move among the items.  Press the  + and  -
keys or click the + and - icons to set the current date and time.  Close

the window by pressing ^ or double-clicking the Control menu box in

the upper-left corner of the window.

Floppy Drives A and B

To  configure  the  floppy  drive,  select  Floppy A.   The  following

values appear on the screen:

After selecting the proper setting, press ^ or double-click the Control

menu box to close the window.

Select  Floppy B and follow the same procedure to configure the

second floppy drive, if present.
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Hard Disk Drives

Select  Master Hard Disk to configure the first hard disk.  The

following values appear on the screen:

If you cannot find your hard disk drive type on the list, select  User
and enter the disk parameters.  You can also select  Utility Setup.

This  automatically  configures your hard disk.   Refer to the section

Utility Setup for more information.

Select ESDI or SCSI depending the device installed.

If you have two hard disks installed, select Slave Disk and follow

the same procedure to configure the second hard disk.
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Advanced CMOS Setup

The window below appears if you select the Advanced option.

The screen above does not show all the parameters of the Advanced

Configuration menu.  Use w or y to highlight the desired parameter.

Press  } to view the rest of the parameters.  The following screens

appear: 
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Typematic Rate (Chars./Sec.)

This parameter determines the typematic rate.  The typematic rate

settings are  15, 20, 30 and  Disabled.  The default setting is 30.
Select Disabled to disregard the rate setting.

                                                                                                                                             
3-6 User’s Guide



AMI BIOS

System Keyboard

Set this parameter to  Present if there is a keyboard connected to

the  system.   However,  some  servers  may  not  have  keyboards.

Select Absent if there is no keyboard present.

Primary Display

This  function  detects  the  type  of  VGA  in  use.   The  settings  are

VGA/EGA, CGA 40 x 25, CGA 80 x 25, Mono, and  Absent.  The

default setting is VGA/EGA.  

PS/2 Mouse Support

Setting this parameter to Enabled lets you support a PS/2 mouse.

Disable  the  parameter  if  you  are  under  the  UNIX  X-window

environment.

Above 1 MB Memory Test

This parameter allows your system to check all  available memory.

Therefore, setting this parameter to Enabled slows down the power-

on self-test.  The default setting is Disabled.
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Memory Test Tick Sound

Enabling  this  parameter  lets  you  hear  the  tick  sound  during  the

memory test.  Disable the parameter to bypass the function.

Hit “Del” Message Display

This option lets you enable or disable the Hit <Del> if you want Setup

message from appearing when the system boots.  The default setting

is Enabled. 

Extended BIOS RAM Area

This function allows you to relocate the BIOS from ROM to RAM.

Relocating  to  RAM  enhances  system  performance  as  information

access is faster than ROM.  The parameter settings are  0:300 and

DOS 1K.  The default address is 0:300.

Wait for F1 If Any Error

When enabled, the BIOS waits  for the end user to press  l before

continuing.  If disabled, the BIOS continues the boot process without

waiting for l to be pressed.  The default setting is Enabled.

System Boot-up Num Lock

Setting  this  parameter  to  On enables  the  numeric  function  of  the

numeric keypad.  Set this parameter to Off to disregard the function.

Disabling the numeric function allows you to use the numeric keypad

for cursor control.  The default setting is On.
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Floppy Drive Seek at Boot

When enabled, the BIOS detects whether there is a floppy disk drive

installed.  Disable the parameter to bypass the function.  The default

setting is Disabled.

Floppy Drive Swapping

This parameter allows you to swap floppy drives.  For example, if you

have two floppy drives (A and B), you can assign the first drive as

drive B and the second drive as drive A or vice-versa.  Disable the

parameter to bypass the function.  The default is Disabled.

System Boot-up Sequence

The  settings  are  C:,  A:  and  A:,  C:  to  specify  the  system search

sequence.  The default setting is A:,C:.

Password Checking

The settings are  Setup and  Always.   The Setup setting allows the

system to  boot  and use  the password  to  protect  the  Setup Utility

Configuration settings from being tampered with.  The Always setting

requires you to enter the password everytime you boot the system.

The default setting is Setup.
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Cache Memory

The available  selections  for  this  parameter  are  Internal,  Both and

Disabled.  Select Internal if you want to enable the internal cache

memory.   Select  Both if  you  want  to  use  both  the  internal  and

external  cache  memories.   Select  Disabled to  disregard  the

internal and external cache features.

System BIOS Shadow Cacheable

The default setting for this parameter is  Enabled.  This enhances

the  system  performance.   Disabling  the  parameter  prevents  the

system BIOS from being cached.

Adapter ROM Control

C000, 32 K

This  address  is  for  shadowing  video  ROMs.  Select  Shadow to

assign the address for shadowing expansion video card with ROM.

Select  Cache to  assign  them  for  cache.   The  default  setting  is

Cache.

C800 ~ DC00, 16 K

These  addresses  are  for  shadowing  other  expansion  card  ROMs.

The  default  setting  for  these  areas  is  Disabled.   Set  the

addresses  to  Shadow if  you  want  to  use  them  for  shadowing

expansion cards with ROM.  Set the addresses to Cache to assign

them for cache.

                                                                                                                                             
3-10 User’s Guide



AMI BIOS

The  F000  and  E000  addresses  are
exclusively shadowed for BIOS.

IDE Control

IDE Auto-detect

There are cases wherein the HDD parameters that you entered and

those detected by the auto-detection function are mismatched.  This

causes the system not to boot.  If this happens, we recommend that

you set this parameter to  Disabled to bypass the auto-detection

function.  The default setting is Enabled.

Block Mode

This function enhances disk performance depending on the hard disk

in use.  This parameter is normally set to Auto.  This setting allows

data transfer in block (multiple sectors) by increasing the data transfer

rate.  The other selections for this parameter are 2 S/B, 4 S/B, 8 S/B,

16 S/B, 32 S/B, 64 S/B and Disabled.  Disable the parameter if your

hard disk does not support this feature.

Onboard IDE Present

The settings for this function are Auto, Enabled and Disabled.  Select

Enabled  if  you  have  an  onboard  PCI  IDE.   Select  Auto to

automatically detect the presence of PCI IDE.  Select Disabled to

disregard the PCI-IDE function.
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PIO Mode

This parameter lets you set the PIO mode that your onboard PCI IDE

supports.   The  selections  are  from Mode 0  to  Mode 4,  Auto and

Disabled.   Set  this  parameter  either  by  entering  the  PIO  mode

manually or selecting Auto to automatically detect the supported PIO

mode.  Disable the parameter to bypass the feature.

32-bit Mode

Enabling  this  function  improves  the  hard  disk  performance  by

increasing  the  data  transfer  rate  from 16-bit  to  32-bit.   The  data

transfer rate is auto-detected by BIOS.

Primary 1st LBA Mode

This  enhanced IDE  feature  allows  you  to  use  a  hard  disk  with  a

capacity  higher than 528 MB.   This  is  made possible  through the

Logical  Block  Address  (LBA)  mode  translation.   This  parameter

affects  the  primary  IDE  hard  disk  drive  connected  to  the  IDE  1

connector.  The default setting is Disabled.

Primary 2nd LBA Mode

This  enhanced IDE  feature  allows  you  to  use  a  hard  disk  with  a

capacity  higher than 528 MB.   This  is  made possible  through the

Logical  Block  Address  (LBA)  mode  translation.   This  parameter

affects  the secondary IDE hard disk drive connected to the IDE 1

connector.  The default setting is Disabled.
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Secondary 1st LBA Mode

This  enhanced IDE  feature  allows  you  to  use  a  hard  disk  with  a

capacity  higher than 528 MB.   This  is  made possible  through the

Logical  Block  Address  (LBA)  mode  translation.   This  parameter

affects  the  primary  IDE  hard  disk  drive  connected  to  the  IDE  2

connector.  The default setting is Disabled.

Secondary 2nd LBA Mode

This  enhanced IDE  feature  allows  you  to  use  a  hard  disk  with  a

capacity  higher than 528 MB.   This  is  made possible  through the

Logical  Block  Address  (LBA)  mode  translation.   This  parameter

affects  the secondary IDE hard disk drive connected to the IDE 2

connector.  The default setting is Disabled.

Secondary Drives Present

This  parameter  lets  you  install  up  to  two  IDE  hard  disks  in  the

secondary channel.  Select None if you do not have any.

Chipset Setup Mode

This function allows you to change the Chipset Setup DRAM control

parameters according to the end-user type.  The available settings

are End-user and  Engineer.  We recommend that you select  End-
user.  See the following section for more details on Chipset Features

Setup.

                                                                                                                                             
User’s Guide 3-13



AMI BIOS

Chipset Features Setup

The Chipset  Features  Setup  controls  the  board's  chipset  settings.

The controls for this menu are the same as for the previous screen.

The Chipset Setup DRAM control parameters differ depending on the

Chipset  Setup Mode setting  in  the Advanced CMOS Setup.   This

screen appears if you select the Chipset option from the Setup menu

and if the Chipset Setup Mode parameter setting is End-user.

The following screen appears if your Chipset Setup Mode parameter

setting is Engineer.  Take note of the DRAM control parameters. 
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Both screens do not show all the parameters of the Chipset Setup

menu.  Use  w or  y to highlight the desired parameter.  Press  } to

view  the  rest  of  the  parameters.   The  following  screens  appear

regardless of the end-user type or the Chipset Setup Mode parameter

setting: 
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This manual describes only the End-user
setting parameters.  

DRAM Control

Speed

This DRAM control parameter lets you set the DRAM speed.  The

speed settings are 60 ns and 70 ns.  The default setting is 70 ns.

Memory Hole

This option lets you assign the system memory area to avoid memory

conflicts.  The settings are 512 ~ 640 K, 15 ~ 16 M and Disabled.
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ISA Control

8-bit I/O Recovery Time

This parameter allows you to set the response time of the 8-bit I/O

connected to your system.  The range is from  1~7 SYSCLK.  The

default setting is 4 SYSCLK.

16-bit I/O Recovery Time

This parameter allows you to set the response time of the 16-bit I/O

connected to your system.  The range is from  1~4 SYSCLK.   The

default setting is 1 SYSCLK.

PCI Control

VGA Palette Snooping

PCI devices support the “palette snooping” technique that enables the

device to control access to their palette registers.

Set  this  parameter  to  Enabled to  activate  the  palette  snooping

function in the PCI VGA devices installed in your system.  

PCI-IDE Card Selection

This parameter allows you to select the PCI-IDE card that you want to

enable.  The board supports a maximum of four PCI-IDE cards.  The

available selections are  Slot  1,  Slot  2,  Slot 3,  Slot  4, and  Absent.

Select Absent if you do not have a PCI card installed.
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PCI Primary IDE INT# Line

This parameter lets you assign an INT for the IDE device connected

to your primary IDE connector.  The settings are INT A, INT B, INT C,

INT D, Absent and  Not Used.  If you do not have a PCI-IDE card

installed in your system and your PCI-IDE Card Selection parameter

setting is Absent, this parameter becomes non-configurable.

PCI Secondary IDE INT# Line

This parameter lets you assign an INT for the IDE device connected

to your secondary IDE connector.  The settings are INT A, INT B, INT

C, INT D, Absent and Not Used.  If you do not have a PCI-IDE card

installed in your system and your PCI-IDE Card Selection parameter

setting is Absent, this parameter becomes non-configurable.

IRQ Allocated

IRQ 3, 4, 5, 7, 9, 10, 11, 14, 15 is for...

These lines allow you to assign the available IRQs to either ISA or

PCI/PnP devices.  
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Power Management Setup

To take advantage of the power management features, select Power
Management from the Setup menu.  To  select,  highlight  Power
Mgmt and press  e or double-click on the Power Management icon.

The following screen appears:

The screen above does not show all  the parameters of the Power

Management  Setup  menu.   Use  w or  y to  highlight  the  desired

parameter.  Press } to view the remaining parameters.  The following

screens appear: 
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Advanced Power Management

Set  this  parameter  to  Enabled to  take  advantage of  the power-

saving feature.  Disable the parameter to bypass the feature.

Full-on to Standby Timeout

This function lets you determine when to put the system into standby

mode.  In standby mode, the CPU clock slows down and the VGA

suspends the video signal.  Any events detected returns the system to

full power.  The settings range from 1~255 Min. and Disabled.

Standby to Suspend Timeout

This function lets you specify when to put the system into suspend

mode.  In suspend mode. the CPU clock stops, the IDE hard disk

spins  down  and  the  VGA  suspends  video  signal.   This  mode

conserves the most power.  Any events detected returns the system

to full power.  The settings range from 1~255 Min. and Disabled.
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IDE Drive Power Down in

This option allows you to specify the mode when to "spin down" your

IDE  hard  disk.   The  disk  returns  to  full  speed  once  the  system

resumes to normal mode.  The settings are  Standby, Suspend and

Disabled.

Video Power Down in

This option allows you to set  the mode when to power down your

video  monitor.   The  video  monitor  returns  to  full  power  once  the

system returns to normal mode.  The settings are Standby, Suspend

and Disabled.

VGA Power Down Mode

This option lets you choose the VGA power down mode.  The settings

are Standby, Suspend and Off.

Slow Clock Ratio

When the system enters the standby mode, the CPU clock starts to

slow down.  This parameter lets you set the “slow-down” clock ratio.

The settings are 1:2, 1:4, 1:8, 1:16, 1:32, 1:64, and 1:128.  

Break Event (IRQ 3~7, 9~15)

Enabling these parameters allows your system to monitor  the IRQ

activities.  Any activity detected resets the power-management timers

and returns the system to normal mode.  
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You must enable at least one IRQ activity.
Otherwise,  the  system stays  in  suspend
mode.

Under  Windows  95,  do  not  disable  the
parameter IRQ 12.  Otherwise, the system
disregards any mouse or keyboard activity
and stays in power-saving mode.  

Peripheral Setup

This screen appears if you select Peripherals or double-click on

the Peripheral Setup icon from the Setup menu.  The Peripheral Setup

screen allows you to set up your system peripherals.  

Programming Mode

The settings for this option are Auto and Manual.  The Manual setting

allows you to set up the screen items manually.  The Auto setting sets

up  all  the  items  automatically  except  for  the  Parallel  Port  Mode

parameter.  
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Onboard FDC

Enabling  this  function  allows  you  to  use  the  onboard  floppy  disk

controller (FDC).  The default setting is Enabled.

Serial Port 1

This parameter allows you to set the base address of serial port 1.

The available settings are 3F8H, 2F8H, 3E8H, 2E8H and Disabled.

Serial Port 2

This parameter allows you to set the base address of serial port 2.

The available settings are 3F8H, 2F8H, 3E8H, 2E8H and Disabled.  

Parallel Port

This parameter allows you to set the base address of the parallel port.

The available settings are 3BCH, 378H, 278H and Disabled.

IRQ Active

This option specifies if the parallel and serial port IRQs are active high

or active low.  The settings are High and Low.

Parallel Port Mode

This  option lets  you  set  the parallel  port  mode.   The settings  are

Normal or Extended.  
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Utility Setup

IDE Setup

This function allows your system to automatically configure your IDE

hard disk(s).  This screen appears if you select IDE Setup.

After a few seconds, the screen below appears showing your disk(s)

parameters.  Select Yes to accept the values.  
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Color Set

This  pop-up  window appears  if  you  select  Color Set from the

Utility Setup menu.  

Color Set lets you specify the color of your windows background.  The

selections are LCD, Army, Pastel, and Sky.

Default Setup

Select  this  option  to  automatically  set  your  system  configuration

parameters.  To select, highlight Default and press e.  

Original

This option loads the values that you saved before shutting off the

system.   The following prompt  appears  if  you choose  Original
from the Default Setup menu.  Select Yes to load the original values.
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Optimal

Choose this option and the BIOS configures the system using the

best-case values to optimize system performance.  However, these

values may not be applicable to your system.  If your system does not

boot  after  choosing  this  setting,  reconfigure  it  using  the  Fail-safe

settings.  Refer to the following section.

The screen below appears if you choose Optimal from the Default

Setup menu.  Select Yes to load the optimum values.

Fail-safe

Choose this option and the BIOS automatically configures the system

using the most stable settings.  These settings are not necessarily the

best settings for system performance, but they are safe and stable

enough to guarantee that your system will boot.  This is useful if you

are having problems with your current system configuration and need

to determine the cause.  

A prompt appears if you choose Fail-safe from the Default Setup

menu.  Select Yes to load the fail-safe values.
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Security Setup

Password

The system password prevents unauthorized use of your computer.  If

you  enabled  the  password  feature,  it  is  impossible  to  boot  the

computer without entering the password.

To set a password, highlight  Password or simply double-click the

Password icon.  The following screen appears:

Your password can consist of up to six characters.  The password

does not appear on the screen.  WinBIOS prompts you to retype the

password.  The following screen appears.
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If  you forget  your  password,  you  must  clear  the CMOS RAM and

reconfigure the system.  

To disable the password, press e when prompted for your password.
Press e again when prompted to retype the password.

                                                                                                                                             
3-28 User’s Guide



AMI BIOS

Anti-virus

Set  this  parameter  to  Enabled to  protect  the  boot  sector  and

partition  table  of  your  hard  disk  from  virus  intrusion.   Set  it  to

Disabled to bypass the feature.  

A prompt appears when you select Anti-virus from the Security

Setup menu:

Select Enabled and the screen below appears:
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Exit Setup

To exit Setup, you can either double-click on the Control menu box or

simply press ^.  A dialog box appears on the screen. 

If  you select  Save Changes and Exit,  BIOS automatically

saves  all  CMOS  values  before  leaving  Setup.   Select Do Not
Save Changes and Exit to  exit  Setup  without  saving  the

CMOS values.  Select  Continue to return to Setup if you want to

reconfigure your system.
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The  LP5  comes  with  an  onboard  S3  Trio64  high-performance

graphics accelerator that greatly enhances display capabilities.  It has

the following features:

· Support for PCI bus

· Supports  GUI  (Graphical  User Interface)  accelerations such as

bit-block  transfer,  line-drawing,  rectangle  fill,  and  windows

clipping to improve performance in a graphics environment

· Screen refresh rate up to 75 Hz

· 1280 x 1024, 256 colors (non-interlaced) maximum resolution

· Resolutions/colors in graphics mode

· 1-MB DRAM

640 x 480 non-interlaced, 64 K colors

800 x 600 non-interlaced, 64 K colors

1024 x 768 non-interlaced, 256 colors

1280 x 1024 non-interlaced, 16 colors

· 2-MB DRAM

640 x 480 non-interlaced, 16.7 million colors (true color)

800 x 600 non-interlaced, 16.7 million colors (true color)

1024 x 768 non-interlaced, 64 K colors

1280 x 1024 non-interlaced, 256 colors

1600 x 1200 interlaced, 256 colors

· Features 132-column text modes

· Register-level compatibility with IBM VGA and backward

· Hardware cursor support
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· Display memory upgradable to 2 MB 

Upgrading Video Memory

You can upgrade the video memory by installing additional memory

chips.  The added memory allows you to use more colors and display

graphics at higher resolutions.

The board comes with 1-MB video display memory.  You can upgrade

this to 2 MB by installing two 256 Kb x 16 DRAMs with an access

speed of 70 nanoseconds or faster.  See the section Board Layout for

the location of the second 1-MB DRAMs.

To upgrade the video memory, follow these steps:

1. Before you upgrade the video memory, check your DRAM type.

Make sure that your upgrade DRAMs and the onboard DRAMs

are exactly of the same type.

2. Align the dot on the DRAM with the notch on the empty socket.

3. Insert the DRAM into the socket.  Make sure the chip orientation

is correct.  Be careful not to bend any pins.
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The  board  automatically  detects  the  memory  size  and  tests  the

memory when you power-on.  Check the memory chip installation if

you receive an error message.

Drivers and Utilities

Getting Started

See to it that you have the following before you install the drivers:

· DOS 5.0, 6.0, 6.2 (or higher version) or OS/2 2.0, 2.1 (or higher

version)

· VGA analog monitor

We recommend that you create backup copies of the original driver

diskettes.  Store the originals and work from the backups.  If the copy

gets  damaged,  use  the original  to  create  a  new copy.   Label  the

working diskettes properly.

Use  the  DISKCOPY  command  to  create
backup  diskettes.   Refer  to  your  MS-DOS
manual for instructions.

Supported Applications

The board comes with a set of display drivers for various applications.

The software drivers for the following applications are contained in the

driver diskettes.

· Windows v3.x

· Autodesk ADI 4.2 Protected mode
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· AutoCAD 11/12

· 3D Studio 1.0/2.0

· AutoShade 2.1

· MicroStation PC

· Protected Mode v4.0

· Protected Mode v5.0

· OS/2 2.x, 3.0

· Windows NT 3.5

· WESU (Power-Saving Utility)

Refer to the README.TXT file contained in each driver diskette for

detailed installation instructions.

After installing the Windows drivers, a Galileo
utility  icon  appears  in  the  Windows  control
panel.  Click-on this icon if  you want to use
the  utility.   The  Galileo  utility  allows you  to
change the resolution and the refresh rates.  
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Display Modes

Standard Display Modes

The table below lists the standard display modes supported by the S3

video BIOS.

Mode
(Hex)

Display
Mode

Screen
Resolution

(Chars)

Colors Buffer
Start

Sweep
/Refresh

Rate
(KHz/Hz)

Dot
Clock
(MHz)

00 Text 40 x 25 b/w B8000 31.5/70 25.175
00+ Text 40 x 25 b/w B8000 31.5/70 28.322
01 Text 40 x 25 16 B8000 31.5/70 25.175
01+ Text 40 x 25 16 B8000 31.5/70 28.322
02 Text 80 x 25 b/w B8000 31.5/70 25.175
02 Text 80 x 25 b/w B8000 31.5/70 25.175
02+ Text 80 x 25 b/w B8000 31.5/70 28.322
03 Text 80 x 25 16 B8000 31.5/70 25.175
03+ Text 80 x 25 16 B8000 31.5/70 28.322
04 Graph 320 x 200 4 B8000 31.5/70 25.175
05 Graph 320 x 200 4 B8000 31.5/70 25.175
06 Graph 640 x 200 2 B8000 31.5/70 25.175
07 Text 80 x 25 Mono B0000 31.5/70 28.322
0D Graph 320 x 200 16 A0000 31.5/70 25.175
0E Graph 640 x 400 16 A0000 31.5/70 25.175
0F Graph 640 x 350 Mono A0000 31.5/70 25.175
10 Graph 640 x 350 16 A0000 31.5/70 25.175
11 Graph 640 x 480 2 A0000 31.5/60 25.175
12 Graph 640 x 480 16 A0000 31.5/60 25.175
13 Graph 320 x 200 256 A0000 31.5/70 25.175

“+” Requires more than 1-MB memory
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Extended Video Modes

The  following  table  lists  the  extended  display  modes  and  the

corresponding resolutions available for each mode.

Mode
No.

Screen Resolution
(Chars)

Colors Refresh Rate (Hz)

10A 132 x 43 16 70
109 132 x 25 16 70
101 640 x 480 256 60
101 640 x 480 256 72
101 640 x 480 256 75
103 800 x 600 256 56
103 800 x 600 256 60
103 800 x 600 256 72
103 800 x 600 256 75
105 1024 x 768 256 43 (I)
105 1024 x 768 256 60
105 1024 x 768 256 70
105 1024 x 768 256 75
106 1280 x 1024 16 45 (I)
+107 1280 x 1024 256 45 (I)
+107 1280 x 1024 256 60
+107 1280 x 1024 256 72
+107 1280 x 1024 256 75
110 640 x 480 32768 60
110 640 x 480 32768 72
110 640 x 480 32768 75
111 640 x 480 16 60
111 640 x 480 16 72
111 640 x 480 16 75
+112 640 x 480 16.7 M 60
+112 640 x 480 16.7 M 72
+112 640 x 480 16.7 M 75
113 800 x 600 32768 60
113 800 x 600 32768 72
113 800 x 600 32768 75
114 800 x 600 65536 60
114 800 x 600 65536 72
114 800 x 600 65536 75
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Extended Video Modes (continued)

Mode
No.

Screen Resolution
(Chars)

Colors Refresh Rate (Hz)

+115 800 x 600 16.7 M 60
+115 800 x 600 16.7 M 72
+115 800 x 600 16.7 M 75
+116 1024 x 768 32768 43 (I)
+116 1024 x 768 32768 60
+116 1024 x 768 32768 70
+116 1024 x 768 32768 75
+117 1024 x 768 65536 43 (I)
+117 1024 x 768 65536 60
+117 1024 x 768 65536 70
+117 1024 x 768 65536 75
+120 1600 x 1200 256 48.5 (I)
201 640 x 480 256 60
201 640 x 480 256 72
201 640 x 480 256 75
203 800 x 600 256 56
203 800 x 600 256 60
203 800 x 600 256 72
203 800 x 600 256 75
205 1024 x 768 256 43 (I)
205 1024 x 768 256 60
205 1024 x 768 256 70
205 1024 x 768 256 75
207 1152 x 864 256 60
208 1280 x 1024 16 43 (I)
208 1280 x 1024 16 60
208 1280 x 1024 16 72
208 1280 x 1024 16 75

   “+” Requires more than 1-MB memory

Extended VGA text modes up to 132 columns
by 43 rows are possible as well.
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Audio Chip 5

The LP5 system board comes with the Windows and DOS application

package for the onboard Creative CT2504 chip.   This chapter tells

how to use these applications.

Driver Installation

To install  the drivers,  simply  insert  the Audio Installation Disk  into

drive A and type:

A:\INSTALL

Follow the screen instructions to complete the installation.

Windows Applications

WaveEditor

WaveEditor allows you to record, play, edit  and enhance 8-bit (tape

quality)  and  16-bit  (CD  quality)  wave  data  in  the  Windows

environment.   

Starting WaveEditor

To start WaveEditor, simply double-click on the WaveEditor icon.  The

WaveEditor window appears as follows.
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Toolbar Contains the buttons and control boxes for file and

wave operations.

Creates a new window without any data.

Loads an existing wave file.

Saves changes made to a wave file.

Cuts the selected data of a wave file.
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Copies the selected data of a wave file.

Pastes cut or copied data onto a wave file.

Plays  the  wave  file  that  is  currently  active  in  the

WaveEditor.

Stops the playback of a wave file.

Pauses/Resumes the playback of a wave file.

Records a wave file.

Sets the default recording format.

Activates the mixer.

Activates the CD player.  (This button appears only if

you have a CD-ROM drive installed.)

Displays  the  starting  position  of  the  wave  data

selection.   To  specify  the  position,  enter  the

numerical value in the text box or use the scrolls to

select the starting position.

Displays  the size of  the wave data selection.   To

adjust the size, enter the desired size in the text box

or use the scroll arrows.

Displays the zoom ratio of the wave file on display.

To adjust the ratio, simply enter the desired ratio in

the text box or use the scroll arrows.  The smaller

the value, the larger the magnification.
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Edit Window Refers to the area where the content of a wave file

is displayed.  You can open several edit windows

at  the  same  time.   This  allows  you  to  perform

editing functions quickly and easily.

Status Bar Displays information related to the wave file in the

active edit window and each menu command. 
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WAVEEDITOR MENUS

WaveEditor has seven menus.  It also has a context-sensitive menu

that you can activate easily with your mouse.

File

The File menu contains the following commands:

New Creates a new window without any data.

Open Loads an existing wave file.

Close Closes an open wave file.

Close All Closes all open wave files.

Save Save changes made to the wave file.

Save As Saves the wave file with a new name.

Save All Saves all open wave files.

Exit Quits WaveEditor. 

WaveEditor keeps a record of the last four wave files that you have

opened by displaying them on the File menu after the Exit command.

To open any of the files, select the file with the left mouse button.

Edit

The Edit menu contains the following commands:

Undo Restores the wave file to the state last saved.

Cut Copies and then removes the selected portion of

the wave data.

Copy Copies the selected portion of the data.

                                                                                                                                             
User’s Guide 5-5



Audio Chip

Paste Pastes  cut  or  copied  wave  data  into  the  Edit

window.

Paste Mix Mixes cut or copied wave data with the one in the

Edit window.  

Delete Deletes a selected portion of the data.  Unlike the

Cut command, the data is not copied first.

Crop to Selection  Deletes  the  entire  data  except  the  portion

selected.

Select All Selects  the entire  wave  file  in  the  Edit  window.

You can also do this by double-clicking the mouse

anywhere within the Edit window.

View

The View menu allows you to customize the WaveEditor workspace:

Toolbar Toggles the Toolbar on or off.

Status Bar Toggles the Status bar on or off.

Fit Wave In WindowScales (adjusts the zoom ratio) the wave display to

fit the size of the Edit window.

Actual Size Resets the zoom ratio of the wave display in the

Edit window to its actual size.

Cursor Position Displays the wave file at the starting point of the

wave selection.

Cursor End Displays the wave file at the ending position of the

wave selection.

Zoom Zooms into the portion of the wave file.

Special Menu
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The Special menu allows you to add special effects to the wave files.  

Reverse Reverses  the playback  of  the entire  or  selected

portion of the wave file.

Add Echo Adds echo effect to the entire or selected portion

of the wave file.  

Rap! Repeats the selected portion of the wave file.

Insert Silence Inserts silence into the selected wave file portion.

Force to Silence Silences the selected wave file portion.

Fade In Fades into the entire or selected wave file portion.

Fade Out Fades out the entire or selected wave file portion.

Amplify Volume Changes the volume level of the entire or selected

wave file portion.

For  stereo  files,  options  for  editing each
channel are available.

Options Menu

The Options menu lets you change the WaveEditor’s default settings.

Record Settings Sets the default record settings.

Mixer Settings Activates the mixer.

Display in Bytes Displays the wave selection information in bytes.

Display in Samples  Displays  the  wave  selection  information  in

milliseconds.

Always on Top Toggles WaveEditor as the topmost window.
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Window Menu

The Window menu allows you to organize the Edit  windows when

several wave files are open.  Refer to your Microsoft Windows manual

for more information on Windows menu commands.

Help Menu

The commands on the Help menu are:

Contents Displays the WaveEditor’s menu contents.

Search Searches the Help menu based on your selected

topic.

System Information  Displays the information about Windows and your

system such as CPU and available memory.

About WaveEditor Opens a window displaying copyright information.

Context-sensitive Menu

The Context-sensitive menu appears when you click the right mouse

button in the Edit window.  It contains the following commands:

Play Plays the entire or selected portion of the wave file

in the Edit window.

Record Records a wave file.  If the current active window

in the Edit window is an open file, the recorded file

replaces the contents in the open file.

Stop Stops the playback of a wave file.

Mixer Settings Activates the mixer.

Fit Wave in Window   Scales the wave display to fit the size of the Edit

window.
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Cursor Position Displays the wave file at the starting position of the

wave selection.

Zoom Zoom into the portion of the selected wave file.

New Creates a new window without any data.

Open Loads an existing wave file.

Save Saves changes made to the wave file.

Working with WaveEditor

SPECIFYING WAVE FORMATS

Before recording a wave file, make sure that the format of the file is

specified correctly.   Wave format  refers  to the sound channel and

sampling rate and file size.

To specify the wave format:

1. Select  Record Setting from the Options menu.  See the

following figure.
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2. Select the format of the wave file.  

· Select Mono for single-channel sound and Stereo for dual-

channel sound.

· Select 11025 Hz for voice-, 22050 Hz for cassette- and

44100 Hz for CD-quality recording.

· Select  8 bits for cassette and  16 bits for CD-quality

sound.

3. Select OK.

A  wave  file  with  better  sound  quality
requires greater space because of its high
sampling rate.  Therefore, the amount of
storage space required for a file depends
on the quality of a wave file
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Opening Wave Files

You can open a wave file using the Open command from the File

menu or the drag-and-drop method.

To use the Open command:

1. Select  Open from the File menu.  The Open Sound File dialog

box appears.

2. From the File Name list  box, select the file you want to open.

You may have to specify the directory that contains your .WAV

files.  Choose Play to listen to the selected wave file.

3. Choose OK.
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If you select a file with raw data (.RAW) or
Creative’s  Voice  format  (.VOC),  a  dialog
box  prompting  you  to  confirm  the
conversion  of  the  file  to  .WAV  format
appears on screen.

To use the drag-and-drop method:

1. Start File Manager and open the directory containing the wave

file.  

2. Arrange  the  windows  in  such  a  way  that  the  file  and  the

WaveEditor windows fit the screen.

3. Hold  the  left  mouse  button  as  you  drag  the  file  into  the

WaveEditor window. 

4. Drop  the file  by  releasing  the  mouse button.   The  file  opens

automatically.

You  may  open  multiple  files  using  the
drag-and-drop method by holding the j key
and  clicking  on  the  files  in  the  File
Manager.

Recording Wave Files

To record a new file:

1. Choose New on the Toolbar.

2. Choose Record on the Toolbar.  The New Recording dialog box

appears.
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3. Make  sure  that  the  settings  in  the  dialog  box  are  properly

specified.

· Check the record level  in the Recording Level group box.

Adjust the level using the Mixer button (if necessary).

· Check the path and the filename created in the Record to

File group box.  Change the filename and the directory

using the Browse button.

· Check the recording format as shown at the bottom of the

dialog box.  To change the format, select the Settings

button.

· Check your system’s storage space as shown at the bottom

of the dialog box.  Make sure that you have sufficient

storage for your file.
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4. Choose Start.

If  you  have  a  CD-ROM  drive  installed,
select the CD Player button to activate the
CD  player.   Also,  select  the  CD  Sync
check box to synchronize the start of the
recording and playback of audio CDs.

To record over an existing file:

1. Activate the file you want to record over.

2. Choose Record on the Toolbar.  The Record Over dialog box

appears.

3. Choose Start.

Saving Wave Files

To save a wave file:
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1. Choose  Save on  the  Toolbar  or  select  Save from  the  File

menu.

2. Enter the name of the file and the path, if prompted.

3. Choose OK.

To save a wave file with a new name or format:

1. Select  Save As from the File  menu.  The Save Sound File

dialog box appears.

2. Enter a new name for the file and the path, if prompted.
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3. Select the desired file format and the compression method from

the Save File as Type and Compression/Conversion drop-down

list boxes, respectively.

4. Choose OK.

Mixing the Data of Different Wave Files

To mix the data contents of two wave files:

1. Activate the first (source) file and select the desired portion of the

file for mixing.

2. Select Copy from the Edit menu.  The data copied is stored in an

internal buffer.

3. Activate the second (target) file and select the location where you

want to insert the copied data.

4. Select Paste Mix from the Edit menu.  The Paste Mix dialog

box appears.
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5. Select the desired channels for copying data from the source file

in the From Buffer User group box and for mixing data with the

target file in the Mix With Wave group box.

· Select Mono Channel for a mono file.

· Select  Left  Channel,  Right  Channel,  or  Both
Channels for a stereo file.

6. Choose OK.

If you did not select a portion of the target file, the data is mixed at the

cursor position.  If you select a portion of the target file, the copied

data in the buffer is mixed with the selected portion.

You cannot mix 8-bit wave data with 16-bit
wave  data.   However,  you  can  convert
both files to either 16-bit or 8-bit sampling
size before mixing them.

Adding Special Effects

WaveEditor allows you to enhance your wave files with special effects

from the Special Menu.  These effects are as follows:

REVERSE

This effect reverses the sequence of the data in the wave file such

that the sound is played backwards.  You must specify the portion of

the file that you want to reverse. Otherwise, this effect reverses the

entire file.

To reverse a file:
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1. Select  Reverse from the Special menu.  The Reverse dialog

box appears.

2. Select the desired channels.  No options are available for editing

a mono file.  

Select  Left  Channel,  Right  Channel,  or  Both
Channels for stereo file.

3. Choose OK.

ADD ECHO

This effect modifies data in the wave file to give an echo effect.  

To add echo to a file:

1. Select Add Echo from the Special menu.  The Add Echo dialog

box appears.
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2. Enter  the  echo  magnitude  (loudness  of  the  echo)  in  the

Magnitude text box.

3. Enter the echo delay (the time between the actual sound and the

echo) in the Echo Delay text box.

4. Select the desired channel for stereo files.

5. Choose OK.

RAP!

This feature repeats the selected portion of the wave file.   This is

useful when you want to create a jerky or stuttering effect for your

voice files.

To repeat a selection:

1. Select a portion of a file.

2. Select Rap! from the Special menu.
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INSERT SILENCE

This effect inserts silence into a selected portion of a wave file.

To insert silence into a file:

1. Select a portion of the wave file.  The length of silence depends

on the length of the portion selected.

2. Select Insert Silence from the Special menu.

The  straight  line  inserted  into  the  selected  portion  represents  the

inserted silence.  

FORCE TO SILENCE

This effect mutes the selected portion of a wave file during playback.  

To mute a file:

1. Select a portion of the file.

2. Select  Force to Silence from the  Special  menu.   The

Force to Silence dialog box appears.
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3. Select the desired channels.  No options are available for editing

a mono file.

Select  Left  Channel,  Right  Channel,  or  Both
Channels for stereo wave file.

4. Choose OK.  The selected portion is replaced by a straight line.

FADE IN AND FADE OUT

To use Fade-in or Fade-out:

1. Select  Fade In from the Special menu.  The Fade In dialog

box appears.

2. Enter the starting magnitude in the Magnitude text box.

3. Select the desired channels for stereo files.

4. Choose OK.
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The file is fades in linearly from the starting
magnitude (volume) to a 100% magnitude
(volume)  for  Fade  In,  and  from  100%
magnitude  to  the  ending  magnitude  for
Fade Out.

AMPLIFY VOLUME

This effect allows you to change the volume of wave files.  

To change the volume of a file:

1. Select Amplify Volume from the Special menu.  The Amplify

Volume dialog box appears.

2. Enter the magnitude in the Magnitude text box.

3. Select the desired channels.

4. Choose OK.
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Customizing the Wave Editor

RECORDING

To customize the record settings:

1. Select  Record Settings from  the  Options  menu.   The

Record Settings dialog box appears.

2. Specify the desired settings.

3. Choose OK.

MIXER

To adjust the Mixer settings:

1. Choose Mixer on the Toolbar.  The Mixer window appears.

2. Specify the desired settings.

Using WaveEditor Effectively

To  use  WaveEditor  effectively,  you  need  to  know  the  amount  of

memory needed to run WaveEditor,  how to manage your files and

how to work with compressed files.

MEMORY REQUIREMENTS

WaveEditor requires about 1 MB of memory.  Memory requirements

increase  when  you  playback  or  record  wave  files,  as  sufficient

memory  is  needed for  the  buffers.   We recommend that  you  run

WaveEditor on at least a 386-based system with 4 MB of RAM under

Windows 3.1.
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When  you  open  a  file  for  editing,  WaveEditor  allocates  a  certain

amount of memory for storing the necessary information and does not

load the entire file into memory.  The file is edited directly from your

hard disk.  Therefore, you can edit files as large as your hard disk can

accommodate.

FILE MANAGEMENT

System Optimizing When  you  record  wave  data,  WaveEditor

stores  recorded  data  directly  to  the  hard  disk.   High-resolution

recording of data, particularly 16-bit data at 44 kHz, takes a longer

time to write to your disk if it is not optimized for speed.    

To  reduce  the  amount  of  time  your  system  spends  reading  and

writing data, compact your hard disk using a disk-compaction utility

such as DEFRAG and install a hard disk cache such as SMARTDrive.

Number of Open Files WaveEditor does not limit the number of files

that you can open.  The number of files WaveEditor can open at a

time depends on how you configure your operating system.  For more

information  on  how  to  do  that,  consult  your  operating  system’s

documentation.

Use of DOS SHARE Utility We  recommend  that  you  use  the

DOS SHARE utility  to  allow proper  file  sharing and locking.   This

prevents accidentally deleting a file while WaveEditor is accessing it.

For  more information on how to use this  utility,  consult  your  DOS

documentation.
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COMPRESSED WAVE FILES

Opening Compressed Files WaveEditor  currently  supports  five

compression  formats:  Microsoft  ADPCM,  CCITT  A-Law,  CCITT  µ-

Law,  IMA/DVI ADPCM, and Creative ADPCM.  

When you open a compressed wave file, WaveEditor decompresses

the file before displaying it.  You must ensure that the file resides on a

drive  that  has  sufficient  disk  space  to  accommodate  the

uncompressed data.

The amount of space required depends on the compression format

adopted.  For CCITT A-Law and µ-Law, the compression ratio is 1:2

(compressed:uncompressed).   For  ADPCM,  the  ratio  is  1:4.   For

example, if you are working with a 1 MB ADPCM file,  you need to

have at least 4 MB of free disk space.

Editing Compressed Files When you open a compressed wave

file  for  editing,  WaveEditor  automatically  compresses the file  when

you save it.   As this can be time consuming for large files, you should

save your work as an uncompressed wave (PCM) file first.  Once you

have  finished  editing,  save  the  file  with  the  desired  compression

format.
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Using CD Sync

The CD synch allows you to synchronize the recording and playback

of audio CDs.  This option is only available if you have a CD-ROM

drive installed in your system.

Recording continues even if you have mistakenly placed a CD-ROM

disk in your drive.  However, the program informs you that there is an

error.  To stop the recording, select Stop on the Toolbar.  Insert the

correct audio CD and click on Record on the Toolbar to record over

your file.  To disregard the CD Sync option, uncheck it  before you

proceed with the recording.

Quitting WaveEditor

To quit WaveEditor, simply select Exit from the File menu.  A dialog

box prompts you to save the changes that you have made ( e.g., if the

changes to the file have not been saved).  

QuickCD

QuickCD allows you to play audio compact discs (CDs) in Windows.  

Setting Up QuickCD

To use the QuickCD, you need to install the MCICDA.DRV driver that

comes with your Windows 3.1 package.  The MCICDA.DRV is the

device driver that allows you to play audio CDs in Windows.

To add the MCICDA.DRV:

1. Double-click on  Control Panel in the Main group window.

The Control Panel group window appears.
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2. Double-click  on  Drivers in  the Control  Panel window.  The

Drivers dialog box appears.

3. Check if the statement [MCI] CD Audio appears in the Installed

Drivers list box.  

· If the statement [MCI] CD Audio appears in the Drivers dialog

box,  choose  Close to  exit  the  Drivers  dialog  box.

Proceed to run QuickCD.  
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· If  the  statement  [MCI]  CD  Audio  does  not  appear  in  the

Drivers dialog box, follow steps 4, 5, 6, and 7 to add this

statement.

4. Choose  Add... from the Drivers dialog box.  The Add dialog

box appears.

5. Select [MCI] CD Audio from the Add dialog box.

6. Choose OK.

7. Restart Windows for the changes to take effect.

Starting QuickCD

After  you  have  set  up  QuickCd,  run  the  program  from  your

Accessories group window.

To start  QuickCD,  simply  double-click  on the QuickCD icon.   The

QuickCD window appears.
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The QuickCD Window

The QuickCD window has the following features:

On/Off switch Quits QuickCD.

Eject button Opens or closes the tray.  Disregard the function if

your drive does not support software eject.

Play button Plays the track shown in the Display box.

Stop button Stops the track.

Pause button Pauses or resumes play.

Previous Track button Plays the previous track.  

Rewind button Rewinds the current track by 10 seconds.  If the

current track is the first track, this feature does not

function.

Fast Forward button Forwards the current track by 10 seconds.  If

the current track is the last track, this feature does

not function.

                                                                                                                                             
User’s Guide 5-29

Control-menu box

Track 
Selectio
n 
Buttons

   Slider
   
Thumb On/

Off

Eject

Play     Previous     Fast
Track         Forward

 Stop   Pause Rewind Next 
Track

Mixer



Audio Chip

Next Track button Plays the next track.  

Mixer button Starts the mixer.

Slider thumb Shows the progress of the playing track.  It also

allows you to rewind or forward the current track.

Track Selection buttons Allow you to select the desired track.  If there

are more than 20 tracks, choose  to display the

rest of the tracks.

Display box Displays  the  current  track  and  duration  of  the

track.

Control-menu box Activates the Control menu.

You may use a mouse or a keyboard to select an option.  To select an

option with a mouse, simply click on the button of the desired option.

To play the selected track, simply click on the Track Selection button.

To forward or rewind the current track, drag the slider thumb.

To select an option using a keyboard, press v then e to activate the

selected option.  To move the slider thumb, use the left or right arrow

key.  To select the Control-menu box, press a-k.

Using the Control Menu

The Control  menu includes commands that  enable you to  perform

various operations such as move, restore, and close the window.

To activate the Control menu:

1. Click  on  the  Control-menu  box.   The  Control  menu  appears

onscreen.
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MENU COMMANDS

Restore Restores QuickCD icon to its control window.

Move Allows you to move QuickCD around the desktop.

Minimize Reduces QuickCD to an icon.

Close Quits QuickCD.

Switch To Opens the Task List dialog box which allows you

to select another application.

Play Plays the current track.

Stop Stops the track.

Pause Pauses or resumes play.

Skip Selects the next track and plays it.  

Always on Top Displays QuickCD on top of the active window.

Preferences Allows you to customize QuickCD.

Mixer Settings Activates the mixer.
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About QuickCD Displays the copyright information about QuickCD.

Help Displays QuickCD Help menu contents.

Customizing QuickCD

To customize QuickCD:

1. Select Preferences from the Control menu.  The Preferences

dialog box appears onscreen.

2. Select the desired options:

· Automatically play when CD is inserted   

Plays an audio CD automatically if it is loaded in the disk

tray when you start QuickCD.

· Continuous playback
Repeats from track 1 after the final track is played.

· Minimize on play
Minimizes QuickCD to an icon when playing audio CDs.

· Stop playback on exit
Stops an audio CD when you exit QuickCD.

3. Choose OK.
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Quitting QuickCD

To quit QuickCD, do any of the following:

· Click on the On/Off switch.

· Select Close from the Control menu.

· Press a-o.

Wave’OLE

Wave’OLE plays and records wave data.  It has play, pause, rewind,

forward, stop and record buttons that allow you to control the wave

files.  

Wave’OLE  supports  Object  Linking  and  Embedding  (OLE)  that

enables you to insert sound into other applications such as write by

linking or embedding them.  Refer to the Microsoft Windows manual

for more information about object linking and embedding.

Starting Wave’OLE

To start Wave’OLE, simply double-click on the Wave’OLE icon.  The

Wave’OLE window appears onscreen.
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WAVE’OLE MENUS

The File Menu

The commands on the File menu are:

New Creates a new wave file.

Open Opens an existing wave file.

Save Saves the wave file.

Save As Saves the wave file with a new name.

Exit Quits Wave’OLE.

Wave’OLE keeps a record of the last four files that you have opened.

These appear at the end of the pull-down list in the File menu.  To

open one of these files, click the file with the left mouse button.
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The Edit Menu

The command on the Edit menu is:

Copy Sound as an Object Copies the sound data and OLE information

to the clipboard.   You can pass the sound data

onto  an  OLE  client  as  an  embedded  or  linked

object.

The Options Menu

The commands on the Options menu are:

Wave Info... Displays information about the sound data such as

the sampling rate and size.

Mixer Settings... Runs the Mixer application.  See the chapter on

Windows mixer for more information.

Recording Settings... Lets  you  set  the  sampling  size,  frequency,

and mono or stereo mode for recording.

Always on Top... Toggles Wave’OLE as the topmost window.

The Help Menu

The commands on the Help menu are:

Contents Displays Wave’OLE Help menu’s contents.

About Wave’OLE Opens a window displaying copyright information.
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Opening a Wave File

To open a wave file:

1. Select  Open from the File  menu.   The  File  Open dialog box

appears.

2. Type or select the wave file that you want to open.  Choose Play

to preview the file before opening it.  The dialog box also gives

you the wave format, data size and file date information.

3. Choose OK.

Playing a Wave File

To play a wave file:

1. Open the wave file.
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2. Click on Play.

To stop playing the wave file, select Stop.

You may control the operations in the Wave’OLE windows with either

a mouse or a keyboard.  To move around the Wave’OLE windows,

use the  v or the left and right arrow keys, or simply drag the slider

thumb with a mouse.  To select  a button, press  k or click  on the

desired button.  

Recording a Wave File

To record a wave file:

1. Select New from the File menu.

2. Choose Record.  The Recording dialog box appears.

To stop the recording, choose Stop.
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Setting Recording Characteristics

To set recording characteristics:

1. Select  Recording Settings from the Options menu.  The

Recording Settings dialog box appears.

2. Select the desired settings.

· Select  Mono for a single-sound channel and  Stereo for

dual-sound channels.  Mono is suitable if you want to

perform voice recording, while stereo is more suitable

for music recording.
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· If you do not select a compression method, select the 8-bits

option for normal recording and 16 bits for high-quality

recording.  

If  you  select  a  compression  method  from  the

Compression drop-down list, the 8-bit and 16-bit options

are grayed out.

· Select  8  KHz or  11  KHz frequency  for  voice-quality

sampling rate,  22 KHz for tape-quality sampling rate,

and 44 KHz for CD-quality sampling rate.

· Choose OK. 

Embedding a Wave File

When you embed a wave file, you load a copy
of the wave file in Wave’OLE and transfer it to
an  application  such  as  Write  that  supports
object  linking  and embedding (OLE).   If  you
edit the wave file in Wave’OLE, the wave file in
Write  is  not  affected  because  you no longer
have any connection to the file in Write.

You can embed a wave file using two methods:

· From a document

· From Wave’OLE

To embed a wave file starting from Write:

1. Open the Write document where you want to embed a wave file.

2. Select Insert Object from the Edit menu.  The Insert Object

dialog box appears onscreen.
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3. Select Wave’OLE.

4. Choose OK.  The Wave’OLE application opens.

5. Select  Open from the File menu to select an existing wave file

(or you can do a recording and save it into a new file before you

include the file in the document).

6. Choose OK.

7. Select  Update Write from the File menu.  This embeds the

wave file into the Write document and an icon representing the

wave file is placed in Write.

8. Select  Exit and Return to Write from the File menu.

This returns to the Write document.

To embed a wave file starting from Wave’OLE:

1. Open Wave’OLE.

2. Record a new wave file or open an existing wave file that you

want to embed.

3. Choose Copy Sound as an Object from the Edit menu.

This places the wave file into the clipboard.

4. Open the Write document where you want to embed the wave

file.
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5. Select Paste Special from the Edit menu in Write.  The icon

representing the embedded wave file appears.
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Linking a Wave File

When you  link  a  wave  file,  you  are  not
making a copy of the wave file.  You are
only making a reference to the wave file.
If you edit the wave file in Wave’OLE, the
wave file in an application such as Write
reflects those changes.

To link a wave file in Write:

1. Open Wave’OLE.

2. Create a new wave file or open an existing file that you want to

link.

3. Save the wave file.

4. Choose Copy sound as an object from the Edit menu.

5. Open the Write document where you want to link the wave file.

6. Select  Paste Link from the Edit  menu in Write.  The icon

representing the wave file appears.

Quitting Wave’OLE

To quit Wave’OLE:

1. Select  Exit from the File menu.  The Wave’OLE dialog box

appears if you have not yet saved the latest changes.
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2. Choose Yes to save the changes, No to quit without saving the

changes, or Cancel to continue working in Wave’OLE.

Mixer Control

Mixer  Control  is  a  Windows-based audio  mixer  that  allows you to

combine and manipulate sound from various audio sources.  With the

mixer, it is possible to control the volume of an audio source while

running other Windows applications,  select  and mix different  audio

sources during record and playback.

Starting the Mixer

To start the mixer, simply double-click on the Mixer control icon.  The

Mixer Control window appears onscreen.
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The Mixer Control Window

DEVICE CONTROL GROUP BOX

The Device Control group box contains sliders that control the volume

of various sources that your audio chip supports. 

All  of  the  above  sources  are  in  stereo
except  Microphone  and  PC  Speaker.
Stereo sources have two sliders to control
the  volume  from  the  left  and  right
channels.  Mono sources have one slider
to control one channel.

MASTER VOLUME GROUP BOX

The Master Volume group box contains sliders that control the overall

volume from your external speakers.
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OUTPUT GROUP BOX

The Output group box contains check boxes that allow you to listen to

or mute the audio from the CD-audio, line-in, and microphone.

You cannot mute the other mixer sources.
For example, if you play audio from a MIDI
source,  you  can  hear  the  audio  if  the
volume is at an audible level.

Menu Bar

The Menu bar consists of three drop-down menus.

SETTING

The Settings menu contains the following commands:

Recording Displays the Recording Control window.

Exit Quits the mixer.
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OPTIONS

The Options menu contains the following commands:

Lock L/R Vol. Locks  both  left  and  right  channels  of  all  stereo

sources, so that both channels move at the same

time when you drag the slider thumb.

Always on Top Displays the mixer as the top-most window.

Save Setting on Exit Saves  all  the  changes made to  the  mixer.

The new setting becomes the default setting when

you run the mixer.

HELP

The Help menu contains the following:

Contents Displays the Mixer Control Help menu contents.

About Mixer Control States  the  copyright  and  credit  information

about the mixer.

You can select the options on mixer with a mouse or a keyboard.  To

use a mouse, simply click the option if it is in a check box.  To adjust

the volume, drag the slider thumb or click the top or the bottom of the

slider.

To select an option with a keyboard, simply press  v.  To adjust the

volume, press the up or down arrow key.  To move through the option

backwards, press j-v.
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Selecting a Record Source

The mixer allows you to select one or combination of the following

audio sources for recording:

· Microphone

· Line-in

· MIDI device

· CD-audio

To select a record source:

1. Select  Recording from  the  Setting  menu.   The  Recording

dialog box appears onscreen.

2. Click the desired check boxes in the Left Iin and Right In group

boxes.  These group boxes allow you to record selected sources

to the left and right channels.

The selected audio source is  marked with a red dot.   To get

stereo recording, click the check boxes.

                                                                                                                                             
User’s Guide 5-47



Audio Chip

3. To  automatically  adjust  input  from the  microphone  to  a  level

suitable for recording, click the AGC check box.  You need to

select at least one of the Microphone check boxes before the

AGC check box is effective for recording.

Saving the Mixer Settings

To save the settings before you exit,  select  Save Setting On
Exit from the Options menu.  

Quitting the Mixer

To quit the mixer, do one of the following:

· Select Exit from the Settings menu.

· Double-click on the Control-menu box.

QuickPlayer

QuickPlayer  allows  you  to  play  a  wide  range  of  multimedia  files

consisting  of  sound,  animation,  movie  and  video  files.   However,

before you play a file, make sure that your appropriate software setup

supports the type of file that you want to play.

Within the Quickplayer, you can start the mixer to adjust the volume

and tone of multimedia files.  If you have installed a CD-ROM drive in

your system, you can also start QuickCD to play audio CDs.

Starting QuickPlayer

To start  QuickPlayer,  simply  double-click  on the QuickPlayer  icon.

The Quickplayer window appears on the screen.
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Playing Multimedia Files

To play a multimedia file:

1. Drop the Drives list  box and select the drive that contains the

desired file.  

2. Drop the List Files of Type list box and select the type of file to be

played.

3. Select  the  directory  path  where  you  stored  the  file  from  the

Directories list box.

The available multimedia files for  that  path appear in  the File

Name list box.  
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4. Select a file in the list box.  The selected file appears in the File

Name text box.

5. Click  on  Play.   Alternatively,  double-click  the file  in  the  File

Name list box.

6. Click on Stop when you want to stop the file.

You can also play all  or  a selection of  multimedia files in the File

Name list box in sequence.  

If you want to play a selection of the multimedia files in the File Name

list box, replace Step 4 with the following:

· Press  and  hold  b while  you  select  the  desired  files  with  the

mouse.

When you play a sequence of multimedia files, you can skip a file and

go to the next one if you desire.  To skip a file in sequence, choose

Skip.

Playing Audio CDs

If you have a CD-ROM drive, you can play audio CDs using QuickCD.

To start QuickCD, select the CDPlayer button to display the QuickCD

window.  For more information, refer to the section on QuickCD.

Adjusting the Volume and Tone

You can adjust the volume and tone with the Windows mixer.  To start

the  mixer,  choose  the  Mixer  button  to  display  the  Mixer  Control

window.  For more information, refer to the section on Mixer Control.
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Quitting QuickPlayer

To quit QuickPlayer, do one of the following:

· Click on Quit.

· Double-click on the Control-menu box.

DOS Utilities

Play Utility

The Play utility allows you to play audio CDs and a wide range of

sound files such as Microsoft Wave (.WAV), Creative Voice (.VOC),

MIDI  (.MID)  and  Creative  Music  (CMF)  files  by  simply  entering  a

command.  Also, the utility gives you the flexibility to play a set of files

with the same extension in sequence without requiring you to specify

each file individually.

Knowing the Play Command

You must  be familiar  with  the Play command line before you play

sound files or audio CDs.

Command Line for Playing Sound Files

The command line for playing sound files is:

PLAY file1 [file2...] [/Q] [/H] [/?]

where:

file1 is the name of the first file you want to play.  
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file2 is  the name of  additional files  of  the same type to

play.

/Q Disables display of playback information (file format,

play  time,  filenames,  key  menu,  and  the  copyright

messages) while a file is playing.

/H or /? Displays description for using Play.

Take note of the following when using Play:

· If you enter Play without any parameters, a description for using

Play appears.

· If  you  enter  a  filename  without  specifying  an  extension,  Play

searches the current directory for that filename.  If more than

one extension for the filename exists, the utility plays only

one file  in the following order of preference: .WAV, .VOC,

MID and CMF.

· Before you play a Creative Music (.CMF) file, you must load the

SBFMDRV.COM driver into memory.  To do this, simply type

SBFMDRV in the directory where the driver is found.  

· When you enter a filename, you can specify part of the filename

and use the *  or  ?  characters  to represent  the remaining

missing characters.  The * character represents one or more

characters  while the ? character represents only a single

character.

For example, the PLAY *.WAV line plays all wave files.  The

PLAY TEST*.WAV  line  plays  all  wave  files  with  filename

beginning with TEST.  The PLAY TEST?.WAV line plays all

wave  files  with  filenames  containing  five  characters  and

beginning with TEST.  
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PLAY  *.*  or  PLAY  TEST.*  lines  do  not
work because PLAY only works with files
of one type collectively.

· When you play a MIDI file, the program searches for the MIDI

environment variable.

The MIDI environment variable specifies the MIDI file format

used and where MIDI data is sent to.  The MIDI data can be

sent to the FM chip, Sound Blaster MIDI, or MPU-401 port.

Generally,  there  are  three  MIDI  file  formats  available:

General MIDI, Extended MIDI and Basic MIDI.

The command for setting the MIDI environment is:

SET MIDI=SYNTH:x  MAP:y  MODE:z

SYNTH:x

x = 1 Specifies internal synthesizer (default).

x = 2 Specifies MIDI port.

MAP:y

y = G Specifies General MIDI file format.

y = E Specifies Extended MIDI file format (default).

y = B Specifies Basic MIDI file format.

MODE:z

z = 0 Supports General MIDI (default).

z = 1 Supports Roland Sound Canvas GS.
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z = 2 Supports Roland MT32.

MODE:  z only  applies  to  Sound  Blaster
AWE32.

Command Line for Playing Audio CDs

The command line for playing audio CDs is:

PLAY CD [/T:xx] [/Q] [/H] [/?]

where:

CD Enables the CD-ROM Drive.

/T:xx Specifies the CD track that you wish to start playing at

(xx is the track number).

/Q Disables  display  of  playback  information  (current

track,  total tracks,  playing time, and the key menu)

while a track is playing.

/H or /? Displays description for using PLAY. 

If  you  do  not  specify  the  track  number
(/T:xx) option,  you  must  press  P to
start playing the CD.

Using Play

The following are some examples of how you can play sound files and

audio CDs in DOS:

· To play a Creative Music File (SONG.CMF):
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1. Make sure SBFMDRV.COM is loaded in memory.

2. Type PLAY SONG.CMF and press e.

· To  play  three  voice  files  (TEST1.VOC,  TEST2.VOC,  and

TEST3.VOC)  in  sequence,  type  PLAY  TEST1.VOC
TEST2.VOC TEST3.VOC and press e.

The command does not  function if  a file
specified does not exist in the directory.

· To play a voice file (TEST1.VOC) without displaying the playback

information, type PLAY TEST1.VOC /Q and press e.

· To play a CD without specifying  the starting track, type  PLAY
CD and press e.

· To play a CD starting at track 5, type PLAY CD /T:5 and press

e.

· To play a CD starting at track 5 without displaying the CD hot

keys, type PLAY CD /T:5 /Q and press e.

Controlling Playback

You can control the playback of files using hot keys.  A menu of the

available  hot  keys  appears  when  you  enter  PLAY without  the  /Q

switch.

WAVE FILE CONTROL HOT KEYS

The following are the hot keys you can use while playing wave files:

C Resumes playing a wave file after a pause.

^ Stop playing a wave file and exits the program.
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N Plays the next wave file in a specific set.

P Plays the previous wave file in a specified set.

k Pauses the playing wave file.

<, > and press e Selects and plays another wave file if more

than one file is specified.

VOICE FILE CONTROL HOT KEYS

The following are the hot keys you can use while playing voice files:

B Stops  a  repeating  section  of  the  voice  file  and

proceeds to the next section.

C Resumes playing a paused voice file.

^ Stops playing the voice file and exits the program.

N Plays the next voice file in a specified set.

P Plays the previous voice file in a specified set.

k Pauses the playing voice file.

<, > and press e Selects and plays another voice file if more

than one file is specified.

MIDI FILE CONTROL HOT KEYS

The following are the hot keys you can use while playing MIDI files:

C Resumes playing a paused MIDI file.

^ Stops the MIDI file  (if  one is playing) and exits  the

program.

x, z Reproduces the sound in a different key by raising or

lowering the pitch.
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M Changes  to  a  different  set  of  musical  instruments

based on the basic, general, and extended standards

on the MIDI mapper. 

N Plays the next MIDI file in a specified set.

P Plays the previous MIDI file in a specified set.

^ Pauses the playing MIDI file.

w, y Changes the tempo of the MIDI file. 

<, > and press e Selects and plays another MIDI file if  more

than one file is specified.

CMF FILE CONTROL HOT KEYS

The following are the hot keys you can use while playing CMF files:

C Resumes playing a paused CMF file.

^ Stops the CMF file (if  one is playing) and exits the

program.

x, z Reproduces the sound in a different key by raising or

lowering the pitch.

N Plays the next CMF file in a specified set.

P Plays the previous CMF file in a specified set.

k Pauses the playing CMF file.

<, > and press e Selects and plays another CMF file if  more

than one file is specified.
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AUDIO CD CONTROL HOT KEYS

The following are the hot keys you can use while playing audio CDs:

C Resumes playing a track.

^ Stops  the  track  (if  one  is  playing)  and  exits  the

program.

F Fast-forwards the track.

L Plays the previous track in a specified set.

N Plays the next track in a specified set.

P Plays a track.

R Rewinds a track.

S Stops a track.

k Pauses a playing track.

X Exits the program.

Record Utility

The Record utility allows you to record sound to a file by specifying

the file type and recording parameters such as the sampling rate and

the recording mode.

Sound is  recorded  into  a  sound file  in  Microsoft  Wave  (.WAV)  or

Creative Voice (.VOC) file format.  
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Knowing the Record Command

Before you record a sound file in wave or voice format, you should be

familiar with the command line syntax of Record.  

The command line for recording wave or voice files is:

RECORD file [/A:xx] [/C:xx] [/M:xx] [/R:xx] [/S:x] 
[/Q] [/H] [/?]

where:

file Specifies the name of the file and its extension, .WAV

or .VOC you want to record sound data into.

/A:xx Sets the record source.

xx = MIC, CD, LINE or FM

You  can  record  from  more  than  one
source.

/C:xx Sets the compression format.

xx = ALAW, MULAW or CTADPCM

/M:xx Sets the record mode.

xx = MONO or STEREO

/R:xx Sets the sample size.

xx = 8 or 16 bits

The  higher  the  sampling  resolution,  the
better is the recording quality.
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/S:xx Sets the sampling rate.

For .VOC format:    xx = 5000 to 44100 Hz

For .WAV format:    xx = 11025, 22050 or 44100 Hz

The  higher  the  sampling  resolution,  the
better is the recording quality.

/Q Disables display of record information.

/H or /? Displays a description on using Record.

Take note of the following when using Record:

· If you enter Record without any parameters, the online description

for using Record appears.

· If  you  did  not  specify  the  recording  mode,  sampling  rate  and

sample  size,  sound  recording  is  in  mono  8–bit  wave  file

format with 11025 Hz sampling rate.

· If you want to stop the recording, press ^.

· Recording stops automatically when the disk is full.

· Record  creates  a  new  file  or  overwrites  an  existing  file  for

recording. 

Using Record

The following are some examples of how you can record sound files

in DOS:

· To record from a CD to a sound file (SONG.VOC) in .VOC format:

1. Play your CD.
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2. Type RECORD SONG.VOC /A:CD and press e.

· To  record  a  sound  file  without  displaying  the  recording

information,  type  RECORD SONG.VOC /A:CD /Q and

press e.

· To record a stereo sound file from a line-in source in .WAV format

with  MULAW  compression,  type  RECORD  SONG.WAV
/A:LINE /M:STEREO /C:MULAW and press e.

Mixerset Utility

The  Mixerset  utility  allows  you  to  control  the  Mixer  settings

interactively.  With the mixer, you can control the volume of various

audio sources supported by the card.

You can use the utility as a command at the DOS prompt or invoke

the  Mixerset  interface  to  control  the  Mixer  settings  through a  full-

screen window consisting of check boxes and sliders.

Knowing the Mixerset Command

The  mixer  is  configured  using  switches  that  follow  the  Mixerset

command. 

To use the Mixerset command:

1. Change to your sound directory.

2. Type MIXERSET [switches] ...  and press e

where  [switches]  can be one or a combination of  any of the

following:

/? or /H Displays help messages.
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/Q Runs  Mixerset  without  displaying  the  setting

information.

/P Sets the mixer according to the PRESET settings in

the CTMIX.CFG file.

/MA:n;x Sets the master volume and balance of the left and

right channels.

/VO:n;x Sets the voice volume and balance of  the left  and

right channels.

/MI:n;x Sets the MIDI volume and balance of the left and right

channels.

/CD:n;x Sets the CD volume and balance of the left and right

channels.

/LI:n;x Sets the Line-in volume and balance of the left and

right channels.

/MIC:n Sets the microphone volume.

/SP:n Sets the PC speaker volume.

n specifies the volume level  and ranges
from 0 to 255.

x specifies the balance of the left and right
channels  and  ranges  from -5  to  +5.   x
must be preceded by ‘;’.

For  example,  /MA:200;5  sets  the  master  volume  at  200  and  the

balance at 5 (this means that the volume will be reduced in the left

channel). /MA:;-5 setting reduces the volume in the right channel.
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/OPS:ss Sets the audio output switches (OPSW) on or off.  ss
represents one or a combination of CDz, LIz and MICz, where z is +

(on) or - (off).

For example, /OPS:CD+ MIC- allows you to receive CD-audio output.

It  does not allow any sound passed through the microphone to be

sent to the speakers.

/IPL:ss Turns  Left  Input  switches  (IPLSW)  on  or  off.   ss
represents one or a combination of  CDRz, CDLz,
MDLz, MDRz, LIRz, LILz, and MICz, where

z is + (on) or - (off).

/IPR:ss Turns Right Input switches (IPRSW) on or off.  Same

as /IPL.

/AGC:+|- Turns Automatic Gain Control (AGC) on (+) or off (-).

Using the Mixerset Command

The following are some examples on how you can use Mixerset:

· To  set  the  PC  speaker  volume  to  200,  type  MIXERSET
/SP:200 and press e.

· To set the master volume to 200 with balanced output through the

left  and  right  channels,  type  MIXERSET /MA:200 and

press  e.  If balance is not specified, both channels are set

equally.

· To  set  all  of  the  above  in  one  command,  type  MIXERSET
/SP:200 /MA:200;0 and press e.
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Starting the Mixerset Control Screen

To start the Mixerset Control Screen:

1. Change to your sound directory.

2. Type  MIXERSET and press  e.   The Mixerset  Control  Screen

appears.

Knowing the Mixerset Control Screen

The Mixerset Control Screen consists of the following components:

· Volume slider

· Balance slider

· Automatic Gain Control check box

· Save button

· Input box

· Output box
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VOLUME SLIDER

Controls the volume levels of the input sources.

BALANCE SLIDER

The sliders control the balance of the left and right speakers for audio

sources with stereo capability.  Moving the slider to the left decreases

the  volume  of  the  right  speaker  but  the  left  speaker  volume

unaffected.  The opposite applies when you move the slider to the

right.

AUTOMATIC GAIN CONTROL CHECK BOX

The Automatic Gain Control (AGC) check box automatically adjusts

input gain from the microphone to a level suitable for recording.

SAVE BUTTON

The  Save  button  saves  all  changes  made  to  the  mixer  to  the

CTMIX.CFG file.   The  new setting  takes  effect  the next  time you

preset the mixer with the command MIXERSET /P.

INPUT BOX

The Input Box enables you to select the audio sources you want to

control as input to the mixer.  The audio sources available are MIDI,

line and microphone input, and CD-audio.  You can direct these audio

sources through the left or/and right input channels of your mixer.

To get a stereo sound effect,  make sure
that  the  left  channel  signal  of  the  audio
source  is  directed  to  the  left-in  channel
and the right signal to the right-in channel.
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OUTPUT BOX

The Output Box enables you to select the audio sources you want to

control as output from the microphone, line-in, and CD-audio to the

left and right speakers.  You can select one or a combination of the

above audio sources playing through the card.

Configuring the Mixer

Using  the  Mixerset  interface,  the  mixer  can  be  configured  with  a

mouse or a keyboard.  

Using a mouse:

· Choose the option if it is a check box.

· Move  the  slider  by  the  click  and  drag  method  or  click  at  the

extreme  end  of  the  slider  to  increase  or  decrease  the

volume.

· To quit Mixerset, click on the Control-menu box.

Using a keyboard:

· Press v to move from one group to another. 

· Press j v to move to a previous group.

· Press w, y to move from one option to another within a group.

· Press x, z to adjust volume.

· Press k or e to select or deselect a check box.

· To quit Mixerset, press ^.
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Jumper Summary     A

CPU Type

CPU Type JP9 JP10 JP11 JP13

P54C-75 1-2 1-2, 3-4 1-2 1-2

P54C-90 2-3 1-2 1-2 1-2

P54C-100 2-3 3-4 1-2 1-2

P54C/CS/CQS-120 2-3 1-2 2-3 1-2

P54C/CS/CQS-133 2-3 3-4 2-3 1-2

P54CS/CQS-150 2-3 1-2 2-3 2-3

P54C/CQS-166 2-3 3-4 2-3 2-3

Memory Mode

Mode JP6

Fast Page 1-2

EDO 2-3

Cache Size

Cache Size JP14

256 KB 2-3

512 KB 1-2

Flash ROM Type

Flash ROM JP7

12V 1-2

5V 2-3

Onboard Super I/O Controller

SMC 665GT JP8

Enabled 1-2

Disabled 2-3
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ECP DMA Channel

ECP DMA Channel JP3 JP4

DMA 1 2-3 2-3

DMA 3 1-2 1-2

VGA

Function JP5

Enabled 1-2

Disabled 2-3

Audio Output

Selection JP1 JP2

Line out 1-2 1-2

Speaker out 2-3 2-3

Audio I/O Address

Selection J1 J2

22XH Closed Closed

24XH Open Closed

26XH Closed Open

28XH Open Open

CMOS

Function JP12

Default (normal) 1-2

Clear CMOS 2-3
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Onboard Connectors

Connector Function

CN1 PS/2-keyboard connector

CN2 PS/2-mouse connector

CN3 COM1 port

CN4 MIDI/game port

CN5 VGA connector

CN6 Wave table

CN7 CD-in connector

CN9 Mic-in (for sound amplifier module)

CN10 Line-out (for sound amplifier module)

CN13 Power connector

CN15 FDC connector

CN16 COM2 port connector

CN17 IDE2 connector

CN18 IDE1 connector

CN19 Parallel port connector

CN20 2-pin fan connector

CN21 Multifunction connector

JK1 Mic-in

JK2 Line-in

JK3 Speaker-out

JP15 HDD LED connector

VR1 Volume control
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